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Development Milestones  
in a Child

Development milestones are a set of functional 
skills or age-specific tasks that most children can do 
at a certain age. These milestones help the teacher 
identify and understand how children differ in 
different age groups.

Age
5 - 8 Years

Physical

Language

Cognitive

Emotional/
Social

•	 First permanent tooth erupts
•	 Shows mature throwing and catching patterns
•	 Writing is now smaller and more readable
•	 Drawings are now more detailed, organised and have a sense of depth

•	 Vocabulary reaches about 10,000 words
•	 Vocabulary increases rapidly throughout middle childhood

•	 Attention continues to improve, becomes more selective and adaptable
•	 Recall, scripted memory, and auto-biographical memory improves
•	 Counts on and counts down, engaging in simple addition and subtraction
•	 Thoughts are now more logical

•	 Ability to predict and interpret emotional reactions of others enhances
•	 Relies more on language to express empathy
•	 Self-conscious emotions of pride and guilt are governed by personal responsibility
•	 Attends to facial and situational cues in interpreting another’s feelings
•	 Peer interaction is now more prosocial, and physical aggression declines

If you cannot do great things, do small things in a great way.



Age 
9 - 11 Years

Age 
11 - 20 Years

Physical

Physical

Language

Cognitive

Cognitive

Emotional/
Social

Emotional/
Social

•	 Motor skills develop resulting in enhanced reflexes

•	 If a girl, reaches peak of growth spurt
•	 If a girl, motor performance gradually increases and then levels off
•	 If a boy, reaches peak and then completes growth spurt
•	 If a boy, motor performance increases dramatically

•	 Ability to use complex grammatical constructions enhances
•	 Conversational strategies are now more refined

•	 Applies several memory strategies at once
•	 Cognitive self-regulation is now improved

•	 Is now more self-conscious and self-focused
•	 Becomes a better everyday planner and decision maker

•	 Self-esteem tends to rise
•	 Peer groups emerge

•	 May show increased gender stereotyping of attitudes and behaviour
•	 May have a conventional moral orientation

Managing the children’s learning needs according to their developmental 
milestones is the key to a successful teaching-learning transaction in the 
classroom.

Family is the most important thing in the world.



Lesson Plans

Knowing yourself is the beginning of all wisdom.

Teaching Pedagogies

Pedagogy is often described as the approach 
to teaching. It is the study of teaching methods 
including the aims of education and the ways in 
which such goals can be achieved.

A lesson plan is the instructor’s road map which specifies what students need to learn and 
how it can be done effectively during the class time. A lesson plan helps teachers in the 
classroom by providing a detailed outline to follow in each class.

A lesson plan addresses and integrates three key components:

  Learning objectives

  Learning activities

  Assessment to check the student’s understanding

A lesson plan provides an outline of the teaching goals:

1.  Identify the learning objectives.
2.  Plan the lesson in an engaging and meaningful manner.
3.  Plan to assess student’s understanding.
4.  Plan for a lesson closure.

Present the lesson plan.

Reflect on what worked well and why. If needed, revise 
the lesson plan. 

Before the class

During the class

After the class



If you have no confidence in self,  
you are twice defeated in the race of life.

Teaching Strategies

Numerous strategies have evolved over the years to facilitate the teaching-learning process 
in the classrooms.

Bloom’s Taxonomy

Bloom’s Taxonomy was created by Dr Benjamin Bloom and several of his colleagues, to 
promote higher forms of thinking in education instead of rote learning. There are three 
domains of learning: cognitive (mental), affective (emotional), and psychomotor (physical). 
However, when we refer to Bloom’s Taxonomy we speak of the cognitive domain. Bloom’s 
Taxonomy is a list of cognitive skills that is used by teachers to determine the level of 
thinking their students have achieved. As a teacher, one should attempt to move students 
up the taxonomy as they progress in their knowledge.

Teachers should focus on helping students to remember information before expecting 
them to understand it, helping them understand it before expecting them to apply it to a 
new situation, and so on.

Student 
Research

Small  
Group  
Work

Performance 
Activities

Direct 
Instruction

Problem 
Solving

Classroom 
Discussion

Cooperative 
Learning

Effective Teaching 
Strategies

Recall facts 
and basic 
concepts

Explain ideas 
or concepts

Use 
information 

in new 
situations, 
to answer 
questions 
or solve 
problems

Take apart 
information 

to show 
relationships, 
causes and 
connections

Justify a 
stand or 
position

Produce 
something 

new

Remembering

Understanding

Applying

Analysing

Evaluating

Creating

LEVEL 1

LEVEL 2

LEVEL 3

LEVEL 4

LEVEL 5

LEVEL 6
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Teaching Objectives

Students will learn about
ªª What is a Table? 
ªª Creating a Table in Word 
ªª Adding Data in a Table 
ªª Selecting Cells, Rows, Columns and Table 
ªª Editing a Table 
ªª Styling a Table 
ªª Merging and Splitting Cells 

Teaching Plan�

Number of Periods
Theory Practical

2 2

Before starting the chapter, ask the students to solve the question in BRIDGE BACK given on page 
8 of the main course book.

Start by introducing the concept of tables in Microsoft Word and explain how tables help organise 
information neatly using rows and columns. Discuss how tables are commonly used to create lists, 
schedules and structured data in documents. 

Explain the parts of a table, such as rows, columns and cells, and demonstrate how each part helps 
organise information clearly.

Discuss the uses of tables in Word documents, such as organising data, comparing values and 
presenting information like timetables or charts.

Explain the two methods of creating tables in Word:

•	 Using the Table Grid option

•	 Using the Insert Table option

Show students how to add data in a table by clicking inside a cell and typing the information. Explain 
the use of the Tab key to move to the next cell and Shift + Tab to move to the previous cell.

Word Tables the Easy Way1
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Explain how to select different parts of a table, such as a single cell, a group of cells, a row, a column 
or the entire table. Demonstrate the use of the Table Move Handle to select the whole table.
Explain how to resize a table using the Table Resize Handle and show how to adjust row height and 
column width.
Introduce the concept of editing a table, which includes modifying the structure or appearance of a 
table. Demonstrate how to add or delete rows and columns using the Table Layout tab.
Discuss how students can move rows or columns within a table using the cut and paste options and 
also teach them about changing row height and column width.
Introduce table styling features, including borders, shading and built-in table styles. Explain how 
these features improve the appearance and readability of tables.
Demonstrate how to change the alignment of text in a table and explain that Word provides several 
alignment options for positioning text inside cells.
Explain the concepts of merging and splitting cells and demonstrate how these features help organise 
table content more effectively.

Extension

Ask the students some oral questions based on this chapter. 
Q.	 What is a table in Microsoft Word and why is it useful?
Q.	 What are the three main parts of a table?
Q.	 What are the two methods used to insert a table in Word?
Q.	 How can you add data to a table cell?
Q.	 How can you select an entire table at once?
Q.	 What is the purpose of table styles in Word?
Q.	 What is the difference between merging cells and splitting cells?

Q.	 How can adjusting row height and column width improve a table?

Evaluation 

Ask the students to complete the elements like ASK AI AGENT given on page 12.

Ask the students to complete the elements like RAPID RECALL given on page 14.

Encourage the students to complete tasks like INTERDISCIPLINARY LEARNING given on page 15.

Motivate the students to complete activities such as LIVE LEARNING on page 16.

After explaining the chapter, let the students do the LEARNING LOGS on pages 17 to 19 in the 
main course book. Tell the students to try sections such as CODE CHECK given on page 20 in the 
main course book.

Take the students to the computer lab and let them practice the activity given in the LAB LEARNING 
section on pages 19 and 20 in the main course book. This will enhance the ability of the students 
and serve as a Critical Thinking and technology literacy activity.
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Suggested Activity

Ask students to create a weekly schedule table in Microsoft Word. They should insert a table with 
four columns add headings such as Day Morning Afternoon and Evening enter activities for each 
day apply a table style and merge the first row to add a title.

Teaching Objectives

Students will learn about
ªª Page Formatting 
ªª Column Formatting 
ªª Borders and Shading 
ªª Mail Merge 

Teaching Plan�

Number of Periods
Theory Practical

2 2

Before starting the chapter, ask the students to solve the question in BRIDGE BACK given on page 
22 of the main course book.

Start by introducing the concept of page formatting in Microsoft Word and explain how formatting 
helps make documents more organised and visually appealing 

Explain the concept of page margins and describe how margins are the blank spaces around the 
edges of a page that improve readability. 

Introduce the concept of page orientation and explain the difference between Portrait and Landscape 
orientation. 

Explain page size and how it determines the width and height of a document. Demonstrate how 
students can change page size from the Layout tab. Mention that the default page size in Word is 
8.5 × 11 inches (Letter size). 

Discuss the concept of page breaks and explain how they help start content on a new page. 
Demonstrate how to insert a page break and mention the shortcut Ctrl + Enter. 

Introduce column formatting, explaining that it divides text into multiple columns. 

Explain borders and shading and discuss how these features enhance the visual appeal of text and 
paragraphs. Demonstrate how to apply a paragraph border to highlight a section of text. 

Introduce the concept of a page border, explaining that it is a decorative frame applied around the 
entire page. Demonstrate the steps to apply a page border and customise its style, colour and width. 

Word Power Tools2



10 CodePilot (Ver. 5.0)-V (Lesson Plan)

Explain the concept of a watermark, describing it as a light text or image placed behind the main 
content of a document. Discuss its uses for indicating document status or adding a design element. 

Introduce Mail Merge, explaining that it allows the same document to be sent to many recipients 
while automatically inserting personalised details such as names and addresses. 

Discuss the three main components of Mail Merge:

•	 Main document – the template containing the fixed content

•	 Data source – the file that stores recipient details

•	 Merge fields – placeholders that insert personalised information

Explain the process of creating a main document, preparing a data source, inserting merge fields 
and finally merging the documents to generate personalised letters. 

Encourage students to practise these formatting and mail merge features to create professional and 
personalised documents.

Extension

Ask the students some oral questions based on this chapter. 

Q.	 What are page margins and why are they important in a document?

Q.	 What is the difference between portrait and landscape orientation?

Q.	 What is the default page size in Microsoft Word?

Q.	 What is the purpose of inserting a page break?

Q.	 What is column formatting and where is it useful?

Q.	 How do borders and shading improve the appearance of text?

Q.	 What is a watermark and why is it used in documents?

Q.	 What are the three main components of Mail Merge?

Q.	 How does Mail Merge help when sending documents to many people?

Evaluation

Ask the students to complete the elements like ASK AI AGENT given on page 31.

Ask the students to complete the elements like RAPID RECALL given on page 26.

Encourage the students to complete tasks like EXPERIENTIAL LEARNING given on page 27.

Motivate the students to complete activities such as LIVE LEARNING on page 31.

After explaining the chapter, let the students do the LEARNING LOGS on pages 32 to 34 in the 
main course book. Tell the students to try sections such as CODE CHECK given on page 35 in the 
main course book.
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Take the students to the computer lab and let them practice the activity given in the LAB LEARNING 
section on page 34 in the main course book. This will enhance the ability of the students and serve 
as a creativity and technology literacy activity.

Suggested Activity

Ask students to create a personalised invitation letter in Microsoft Word. They should adjust page 
margins and orientation insert two columns add a page border and shading insert a custom watermark 
and use Mail Merge to create invitations for multiple recipients. Discuss how these features help 
create well-formatted and professional documents.

Teaching Objectives

Students will learn about
ªª Templates 
ªª Themes 
ªª Inserting Text Box 
ªª Inserting Graphical Objects in a Slide 
ªª Grouping and Ungrouping Objects 
ªª Different Presentation Views 

Teaching Plan�

Number of Periods
Theory Practical

2 2

Before starting the chapter, ask the students to solve the question in BRIDGE BACK given on page 
38 of the main course book.

Start by introducing the concept of presentations in Microsoft PowerPoint and explain how 
presentations help share ideas using slides, text and graphics. Discuss how using attractive layouts 
and visual elements can make presentations more engaging and effective.

Explain the concept of templates in PowerPoint, describing them as pre-designed slides that include 
fixed layouts, colour schemes and formatting to help create presentations quickly. Demonstrate how 
to use templates by selecting a template from the File tab and New option. 

Introduce the concept of themes, explaining that themes provide a consistent design across slides 
by applying a set of colours, fonts and effects. Demonstrate how to apply themes from the Design 
tab and show how students can preview different themes before selecting one. 

Explain the use of a text box and how it allows users to insert text anywhere on a slide. Demonstrate 
how to insert a text box from the Insert tab and type the required content inside it. 

Slides that Impress3
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Introduce graphical objects in PowerPoint and explain how they improve the clarity and visual appeal 
of slides. Discuss how students can insert pictures from their device or use stock images to enhance 
presentations. Demonstrate inserting pictures using the Insert tab and Pictures option. 

Explain how shapes can be inserted into slides to create diagrams, highlight ideas or improve slide 
design. Demonstrate how to insert shapes from the Insert tab and Shapes option.

Discuss how shapes can be resized and rotated to adjust their size and orientation on the slide. Show 
students how to use corner handles to resize shapes and rotation handles to change their angle. 

Explain how to change the fill colour and outline colour of shapes to make slides more attractive. 
Demonstrate using the Shape Format tab to apply colours and effects.

Introduce the shadow effect, explaining how it can be applied to shapes to create a three-dimensional 
look or to make objects stand out. 

Explain the concept of SmartArt graphics, describing them as visual diagrams that help present 
information and ideas clearly using graphics and text. Demonstrate how to insert SmartArt from the 
Insert tab and SmartArt option. 

Discuss grouping and ungrouping objects, explaining that multiple objects on a slide can be grouped 
together so they can be moved or edited as one unit. Demonstrate grouping objects by selecting 
them while holding the Ctrl key and using the Group option. 

Introduce different presentation views in PowerPoint, explaining that each view helps perform a 
different task while working on a presentation. 

Explain the following views:

•	 �Normal View – the default view used to create and edit slides. It contains the slide area, slides 
pane and notes pane.

•	 Outline View – displays the slide text in a simple list format to organise content easily.

•	 Slide Sorter View – shows slides as thumbnails and allows rearranging or managing slides.

•	 Notes Page View – shows a slide with space below for presenter notes.

•	 Reading View – displays the presentation in full screen while keeping navigation controls visible.

Explain the Slide Show mode, which is used to present slides to an audience in full-screen view with 
animations and transitions.

Encourage students to practise using these features to create attractive and professional presentations.

Extension

Ask the students some oral questions based on this chapter.

Q.	 What is a template in PowerPoint and why is it useful?

Q.	 What is the difference between a template and a theme?

Q.	 What is the purpose of inserting a text box in a slide?

Q.	 Why are pictures and graphical objects used in presentations?
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Q.	 What is SmartArt and how does it help present information clearly?

Q.	 What is the use of grouping objects in a slide?

Q.	 What is the default view used in PowerPoint?

Q.	 What is the purpose of the Slide Sorter view?

Q.	 How does Notes Page view help presenters during a presentation?

Evaluation 

Ask the students to complete the elements like ASK AI AGENT given on page 45.

Ask the students to complete the elements like RAPID RECALL given on page 43.

Encourage the students to complete tasks like EXPERIENTIAL LEARNING given on page 44.

Motivate the students to complete activities such as LIVE LEARNING on page 44.

 After explaining the chapter, let the students do the LEARNING LOGS on pages 49 to 51 in the 
main course book. Tell the students to try sections such as CODE CHECK given on page 52 in the 
main course book.

Take the students to the computer lab and let them practice the activity given in the LAB LEARNING 
section on page 51 in the main course book. This will enhance the ability of the students and serve 
as a creativity and technology literacy activity.

Suggested Activity

Ask students to create a two-slide PowerPoint presentation on any topic. They should apply a 
theme insert text boxes and pictures add shapes or SmartArt use colours and shadow effects and 
arrange the slides using Slide Sorter View. Discuss how these features help create clear and engaging 
presentations.

Teaching Objectives

Students will learn about
ªª Inserting Audio	 ª	 Inserting Video
ªª Tables in PowerPoint	 ª	 Working with Slide Master 

Teaching Plan�

Number of Periods
Theory Practical

2 2

Before starting the chapter, ask the students to solve the question in BRIDGE BACK given on page 
54 of the main course book.

Adding Life to Slides4
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Q.	 What is the purpose of inserting a table in a presentation?

Q.	 What is meant by table style in PowerPoint?

Q.	 What is the Slide Master feature and why is it useful?

Q.	 How does Slide Master help maintain consistency in presentations?

Q.	 What is the difference between inserting audio and recording audio in PowerPoint?

Evaluation

Ask the students to complete the elements like ASK AI AGENT given on page 58.

Ask the students to complete the elements like RAPID RECALL given on pages 56 and 63.

Encourage the students to complete tasks like INTERDISCIPLINARY LEARNING ACTIVITY  given 
on page 59.

After explaining the chapter, let the students do the LEARNING LOGS on pages 60 to 62 in the 
main course book. Tell the students to try sections such as CODE CHECK given on page 63 in the 
main course book.

Take the students to the computer lab and let them practice the activity given in the LAB LEARNING 
section on page 62 in the main course book. This will enhance the ability of the students and serve 
as a technology literacy activity.

Suggested Activity

Ask students to enhance their presentation by inserting audio narration for one slide and adding a 
short video clip related to the topic. They should create a table to present key points apply a table 
style and use Slide Master to maintain the same background and font style on all slides. Discuss how 
multimedia and consistent design help create clear and engaging presentations.

Teaching Objectives

Students will learn about
ªª Introduction to Excel	 ª	 Starting Excel 
ªª Components of Excel	 ª	 Changing the Active Cell 
ªª Creating a New Workbook	 ª	 Data Types in Excel 
ªª Entering Data in a Worksheet	 ª	 Saving and Closing a Workbook 
ªª Opening a Saved Workbook 

Understanding Excel5

Start by introducing the concept of enhancing presentations using multimedia and explain how adding 
audio and video can make presentations more engaging and interactive for the audience. Discuss 
how multimedia elements help explain complex ideas more clearly and keep the audience interested. 

Explain the concept of inserting audio in PowerPoint and describe how audio files can be added from 
a computer or recorded directly within a presentation. Demonstrate the steps to insert an audio file 
using the Insert tab and Audio option. 

Discuss different audio file formats that can be inserted into a presentation, such as AIFF, MP3, MP4 
audio, WAV and WMA. Explain that once the audio is inserted, the Audio Format and Playback tabs 
appear on the Ribbon to manage the audio settings. 

Explain how students can also record audio directly within PowerPoint using the Record Audio 
option. Demonstrate the functions of the Play, Stop and Record buttons in the recording dialog box.

Introduce the concept of inserting video in PowerPoint and explain how videos help explain ideas 
visually and make the presentation easier to understand. Demonstrate the steps to insert a video 
using the Insert tab and Video option. 

Explain that videos can be inserted from a device or through the Online Videos option, where the 
URL and thumbnail of the video are added to the slide. 

Introduce the concept of tables in PowerPoint, explaining that tables organise information using 
rows and columns so that the data is easy to read and understand. Demonstrate how to insert a 
table using the Insert tab and Table option. 

Explain the advantage of using the table grid preview, which allows users to see how the table will 
appear on the slide while selecting the number of rows and columns.

Discuss the concept of table styles, explaining that they allow users to change the appearance of 
tables by applying different colours and designs. Demonstrate how to apply a table style using the 
Table Design tab. 

Introduce the concept of Slide Master, explaining that it helps change the overall design of a 
presentation by editing the background, font and layout of all slides at once. This helps maintain 
consistency and saves time when formatting presentations. 

Demonstrate how to open the Slide Master view from the View tab and explain how different slide 
layouts appear in the left pane and can be customised as needed.

Encourage students to practise adding multimedia elements, tables and using the Slide Master 
feature to create well-organised and engaging presentations.

Extension

Ask the students some oral questions based on this chapter. 

Q.	 Why are audio and video used in presentations?

Q.	 What are some audio file formats that can be inserted into PowerPoint?

Q.	 What is the advantage of adding a video to a slide?
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Q.	 What is the purpose of inserting a table in a presentation?

Q.	 What is meant by table style in PowerPoint?

Q.	 What is the Slide Master feature and why is it useful?

Q.	 How does Slide Master help maintain consistency in presentations?

Q.	 What is the difference between inserting audio and recording audio in PowerPoint?

Evaluation

Ask the students to complete the elements like ASK AI AGENT given on page 58.

Ask the students to complete the elements like RAPID RECALL given on pages 56 and 63.

Encourage the students to complete tasks like INTERDISCIPLINARY LEARNING ACTIVITY  given 
on page 59.

After explaining the chapter, let the students do the LEARNING LOGS on pages 60 to 62 in the 
main course book. Tell the students to try sections such as CODE CHECK given on page 63 in the 
main course book.

Take the students to the computer lab and let them practice the activity given in the LAB LEARNING 
section on page 62 in the main course book. This will enhance the ability of the students and serve 
as a technology literacy activity.

Suggested Activity

Ask students to enhance their presentation by inserting audio narration for one slide and adding a 
short video clip related to the topic. They should create a table to present key points apply a table 
style and use Slide Master to maintain the same background and font style on all slides. Discuss how 
multimedia and consistent design help create clear and engaging presentations.

Teaching Objectives

Students will learn about
ªª Introduction to Excel	 ª	 Starting Excel 
ªª Components of Excel	 ª	 Changing the Active Cell 
ªª Creating a New Workbook	 ª	 Data Types in Excel 
ªª Entering Data in a Worksheet	 ª	 Saving and Closing a Workbook 
ªª Opening a Saved Workbook 

Understanding Excel5
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Teaching Plan�

Number of Periods
Theory Practical

2 2

Before starting the chapter, ask the students to solve the question in BRIDGE BACK given on page 
65 of the main course book.

Start by introducing the concept of Microsoft Excel and explain that Excel is used to organise 
information and perform calculations using rows and columns. Explain that Excel is also known as 
an electronic spreadsheet that helps manage and analyse data efficiently. 

Discuss the features of Excel, such as organising data in rows and columns, performing mathematical 
calculations using formulas, creating charts, formatting data and sorting information alphabetically 
or numerically. 

Explain how to start Excel by clicking the Start button, typing Excel in the search bar and selecting 
the application. Demonstrate how a new workbook opens with a default worksheet. 

Introduce the concept of a workbook and worksheet. Explain that a workbook is like a notebook 
containing different worksheets, and a worksheet is the grid where data is entered and organised. 

Discuss the components of the Excel window, such as the Title Bar, Quick Access Toolbar, Ribbon, 
Formula Bar, Name Box, Row Headings, Column Headings and Status Bar. Explain how these 
components help users work efficiently in Excel. 

Explain the structure of a worksheet by describing rows, columns and cells. Mention that rows are 
numbered while columns are labelled alphabetically and that the intersection of a row and column 
forms a cell with a unique address. 

Introduce the concept of the active cell, which is the currently selected cell where data can be entered. 
Demonstrate how the Name Box shows the address of the active cell.

Explain how to change the active cell by clicking another cell or by using keyboard keys such as 
Enter, Tab or arrow keys to move across the worksheet. 

Introduce the concept of creating a new workbook and demonstrate the steps using the File tab and 
the New option. Mention the shortcut Ctrl + N for creating a new workbook. 

Explain data types in Excel, such as Text, Number, Date and Time. Provide examples of each type 
and explain how different data types help organise information properly. 

Demonstrate how to enter data in a worksheet by selecting a cell and typing information. Explain 
that the typed content appears in the Formula Bar and pressing Enter or Tab moves the active cell. 

Discuss the different mouse pointer shapes in Excel and explain how they help perform actions such 
as selecting cells, copying formulas or adjusting row height and column width. 

Explain how to save a workbook using the File tab and Save or Save As option. Mention the shortcut 
Ctrl + S and demonstrate how to choose a location and name for the workbook. 

Finally, explain how to open a saved workbook using the File tab and Open option. Mention the 
shortcut Ctrl + O for opening an existing file. 
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Encourage students to practise entering data and saving workbooks to develop confidence in using 
Excel.

Extension 

Ask the students some oral questions based on this chapter. 

Q.	 What is Microsoft Excel and why is it useful?

Q.	 What is meant by an electronic spreadsheet?

Q.	 What is the difference between a workbook and a worksheet?

Q.	 What is a cell address in Excel?

Q.	 What is an active cell and how can you change it?

Q.	 What are the different data types used in Excel?

Q.	 Why is it important to save a workbook?

Q.	 What shortcut keys are used to create a new workbook and save a workbook?

Evaluation

Ask the students to complete the elements like ASK AI AGENT given on page 70.

Ask the students to complete the elements like RAPID RECALL given on page 68.

Encourage the students to complete tasks like EXPERIENTIAL LEARNING ACTIVITY given on page 
70.

After explaining the chapter, let the students do the LEARNING LOGS on pages 73 to 75 in the 
main course book. Tell the students to try sections such as CODE CHECK given on page 76 in the 
main course book.

Take the students to the computer lab and let them practice the activity given in the LAB LEARNING 
section on page 75 in the main course book. This will enhance the ability of the students and serve 
as a technology literacy activity.

Suggested Activity

Ask students to create a simple Excel worksheet for a weekly study plan. They should create a new 
workbook add headings such as Day Subject Time and Homework enter text and time data adjust 
column width and save the workbook with a suitable file name. Discuss how Excel helps organise 
information clearly and manage schedules and lists easily.
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Teaching Objectives

Students will learn about
ªª Services on the Internet 
ªª Searching for Information 
ªª Communication 
ªª Social Networking 
ªª Blogs 
ªª E-Banking 
ªª Cloud Storage

Teaching Plan�

Number of Periods
Theory Practical

3 1

Before starting the chapter, ask the students to solve the question in BRIDGE BACK given on page 
81 of the main course book:
Start by introducing the concept of the Internet and explain that it provides many services that allow 
people to search for information, communicate with others and store files online. Explain that Internet 
services include different tools and applications that make online activities easier and more useful. 
Explain the concept of services on the Internet and discuss how they allow users to perform various 
tasks such as searching for information, sending messages, chatting with friends and storing files 
securely. 
Introduce the concept of searching for information using search engines. Explain that search engines 
such as Google and Bing help users find websites, images and videos by typing keywords related 
to the information they want. 
Discuss the concept of communication on the Internet and explain how people can communicate 
globally through email, instant messaging, video calls and social networking platforms.
Explain email (electronic mail) as one of the most popular Internet services used to send and receive 
messages and files quickly through computers or mobile devices. 
Introduce the concept of an email address, explaining that it is a unique online identifier used to 
send and receive emails. Explain that it contains a username and a domain name separated by the 
@ symbol. 
Explain the steps for creating an email account using an email service provider such as Gmail. 
Demonstrate how users can sign up by entering their details, creating a username and setting a 
secure password.

Exploring the Online World6
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Discuss the components of an email window, such as Inbox, Compose, Sent, Spam, Drafts and Trash. 
Explain the purpose of each component and how they help manage emails efficiently. 
Explain how to sign in to an email account and demonstrate the steps to enter the email address 
and password.
Introduce the concept of composing and sending an email, explaining the fields in the email window 
such as To, Subject, Message Body, Cc and Bcc. Demonstrate how to attach files and send an email 
message. 
Explain how to read an email from the inbox and discuss the importance of signing out (logging 
out) after using an email account to protect privacy and security.
Introduce video conferencing, explaining that it allows people to communicate face to face through 
the Internet using cameras and microphones. Discuss its use in online classes, meetings and virtual 
collaboration. 
Explain the concept of Voice over Internet Protocol (VoIP) and how it allows voice calls over the 
Internet instead of traditional phone lines. Mention applications such as WhatsApp that allow users 
to make calls and send messages. 
Discuss the concept of chatting, explaining that it allows users to send instant written messages 
using text, emojis and stickers.
Introduce social networking, explaining that social networking sites help people connect with others, 
share posts, photos and videos and interact with friends and communities online. 
Discuss examples of popular social networking platforms such as Facebook, Instagram and X.
Introduce the concept of blogs, explaining that a blog is an online journal where individuals share 
ideas, experiences or information about different topics. Mention that people who write blogs are 
called bloggers. 
Explain the steps for creating and publishing a blog using blogging platforms such as Blogger or 
WordPress.
Discuss the concept of e-banking, explaining that it allows users to perform banking activities such 
as checking balances, transferring money and paying bills through the Internet. Emphasise the 
importance of keeping passwords and OTPs private. 
Finally, introduce cloud storage, explaining that it allows users to store files online and access them 
from any device with an Internet connection. Provide examples such as Google Drive, OneDrive, 
iCloud and Dropbox. 
Encourage students to practise responsible and safe behaviour while using Internet services.

Extension

Ask the students some oral questions based on this chapter.

Q.	 What are Internet services and why are they useful?

Q.	 How do search engines help users find information online?
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Q.	 What is an email address and what are its main parts?

Q.	 What are the important components of an email window?

Q.	 What is video conferencing and where is it commonly used?

Q.	 What is VoIP and how does it work?

Q.	 What is the purpose of social networking sites?

Q.	 What is a blog and who is called a blogger?

Q.	  What is e-banking and why is it convenient?

Q.	 What is cloud storage and why is it useful?

Evaluation

Ask the students to complete the elements like ASK AI AGENT given on page 90.

Ask the students to complete the elements like RAPID RECALL given on page 87.

Encourage the students to complete tasks like ART INTEGRATION ACTIVITY given on page 88.

After explaining the chapter, let the students do the LEARNING LOGS on pages 92 to 94 in the 
main course book. Tell the students to try sections such as CODE CHECK given on pages 94 and 
95 in the main course book.

Take the students to the computer lab and let them practice the activity given in the LAB LEARNING 
section on pages 94 and 95 in the main course book. This will enhance the ability of the students 
and serve as a technology literacy activity.

Suggested Activity

Ask students to create a simple digital communication activity. They should write a sample email 
inviting friends to a school event include fields such as To Subject and Message Body attach a file 
or image explore a cloud storage service to upload and share a document and discuss safe Internet 
practices. Discuss how Internet services help people communicate learn share information and 
manage tasks efficiently.

Teaching Objectives
ªª Collecting Data 
ªª Sorting Data 
ªª Trends and Anomalies in Data 
ªª Data for Decisions 

Smart with Data7
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Teaching Plan�

Number of Periods
Theory Practical

3 1

Before starting the chapter, ask the students to solve the question in BRIDGE BACK given on page 
97 of the main course book.

Start by introducing the concept of data and explain that data are facts, numbers or observations 
collected to gain new understanding. Explain that data becomes useful when it is organised and 
analysed properly. 

Explain the concept of data processing and discuss that it is the process of converting raw data into 
meaningful and useful information through steps such as cleaning, organising and analysing data. 

Introduce the idea of collecting data and explain that surveys are one of the most common methods 
of collecting information. A survey involves asking questions to gather responses from people. 

Discuss how to prepare effective survey questions. Explain that survey questions should be simple, 
clear and unbiased. Also explain the importance of testing the survey with a small group before 
collecting responses from many people. 

Introduce the concept of sorting data and explain that sorting means arranging information in a 
clear and organised order. Give examples such as arranging names alphabetically or arranging marks 
from smallest to largest. 

Discuss the different ways of sorting data, including alphabetical order, numerical order and date 
order. Explain when each type of sorting is used. 

Introduce the concept of trends in data. Explain that a trend shows the general direction in which 
data changes over time, such as increasing, decreasing or remaining stable. 

Explain the concept of an anomaly in data, which is a value or result that is unusual or does not 
match the normal pattern of the data. 

Explain the concept of using data for decision-making. Discuss how analysing data helps people 
choose the best option among different choices and make predictions about the future. 

Extension 

Ask the students some oral questions based on this chapter.

Q.	 What is data and why is it important?

Q.	 What is data processing?

Q.	 What is a survey and why is it useful?

Q.	 What are some rules for preparing good survey questions?

Q.	 What does sorting data mean?

Q.	 What are the different ways of sorting data?

Q.	 What is a trend in data?
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Q.	 What is an anomaly in data?

Q.	 How can data help in making decisions?

Q.	 Why is it important to keep survey responses private?

Evaluation

Ask the students to complete the elements like ASK AI AGENT given on page 103.

Ask the students to complete the elements like RAPID RECALL given on page 99.

Motivate the students to complete activities such as LIVE LEARNING on page 101.

After explaining the chapter, let the students do the LEARNING LOGS on pages 104 to 106 in the 
main course book. Tell the students to try sections such as CODE CHECK given on page 107 in the 
main course book.

Take the students to the computer lab and let them practice the activity given in the LAB LEARNING 
section on page 106 in the main course book. This will enhance the ability of the students and serve 
as a technology literacy activity.

Suggested Activity

Ask students to conduct a classroom survey on favourite subjects or hobbies. They should prepare 
a survey form collect responses from 10–20 classmates record the data in a table or Excel sheet 
sort the data and identify common responses and unusual results. Discuss how this data can help 
teachers plan school activities clubs and learning programmes.

Teaching Objectives

Students will learn about
ªª Working with Multiple Sprites 
ªª Broadcast and Receive Blocks 
ªª Variables 
ªª Creating a Game in Scratch 
ªª Using the AI Features of Scratch 

Teaching Plan�

Number of Periods
Theory Practical

2 2

Before starting the chapter, ask the students to solve the question in BRIDGE BACK given on page 
110 of the main course book.

SCRATCH Meets AI8
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Start by introducing the concept of Scratch programming and explain that Scratch allows users 
to create interactive stories, games and animations using visual programming blocks. Explain that 
Scratch projects can include multiple characters called sprites that interact with each other. 

Explain the concept of working with multiple sprites. Discuss how each sprite in Scratch can have 
its own script and behaviour, allowing different characters to move, speak or perform actions 
independently. 

Demonstrate how to add multiple sprites and a backdrop from the Scratch library. Explain how 
students can change the position and size of sprites using the Sprite Info pane and run the project 
using the Green Flag button. 

Introduce the Broadcast and Receive blocks and explain that these blocks allow sprites to communicate 
with each other. When one sprite broadcasts a message, other sprites can receive the message and 
perform actions accordingly. 

Explain the use of the broadcast message, broadcast and wait and when I receive blocks. Demonstrate 
how these blocks help coordinate actions between different sprites in a story or game. 

Introduce the concept of variables in Scratch. Explain that variables are like labelled containers used 
to store information such as scores, counts or names during the execution of a project. 

Discuss the two types of variables in Scratch:

•	 Global variables, which can be accessed by all sprites.

•	 Local variables, which are used only by a specific sprite. 

Demonstrate how variables can be used in projects to track scores or store changing values.

Explain the steps to create a simple game in Scratch. Show students how to control a sprite using 
arrow keys and increase a score when the sprite touches another object. Explain how the game ends 
when the score reaches a certain value. 

Introduce the concept of extensions in Scratch and explain that extensions add extra blocks that allow 
new features to be used in projects. Students can add extensions using the Add Extension button. 

Explain the Video Sensing extension, which allows the webcam to detect movement and use it to 
control actions in the project. 

Introduce the Text to Speech extension and explain that it allows sprites to speak text aloud using 
different voices and languages. 

Explain the Translate extension, which allows users to translate text into different languages.

Extension

Ask the students some oral questions based on this chapter.

Q.	 What are sprites in Scratch?

Q.	 How can multiple sprites work together in a Scratch project?

Q.	 What are Broadcast and Receive blocks used for?
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Q.	 What is a variable in Scratch?

Q.	 What is the difference between global and local variables?

Q.	 How can variables be used in a Scratch game?

Q.	 What are Scratch extensions?

Q.	 How does the Video Sensing extension work?

Q.	 What is the purpose of the Text to Speech extension?

Q.	 How does the Translate extension help in Scratch projects?

Evaluation

Ask the students to complete the elements like ASK AI AGENT given on page 117.

Ask the students to complete the elements like RAPID RECALL given on page 112.

Encourage the students to complete tasks like INTERDISCIPLINARY LEARNING given on page 119.

Motivate the students to complete activities such as LIVE LEARNING on page 116.

After explaining the chapter, let the students do the LEARNING LOGS on pages 120 to 122 in the 
main course book. Tell the students to try sections such as CODE CHECK given on page 123 in the 
main course book.

Take the students to the computer lab and let them practice the activity given in the LAB LEARNING 
section on page 122  in the main course book. This will enhance the ability of the students and serve 
as a technology literacy activity.

Suggested Activity

Ask students to create a simple Scratch interactive story or game. They should add two or more 
sprites create scripts using broadcast messages use a variable to track score or progress add a 
Scratch extension such as Text to Speech or Translate and run the project using the Green Flag. 
Ask students to present their projects and explain how sprites variables and extensions make the 
program interactive.

Teaching Objectives

Students will learn about
ªª What are Apps?	 ª	 Features of Mobile Apps 
ªª Types of Mobile Apps	 ª	 Categories of Apps 
ªª App Inventor	 ª	 Starting MIT App Inventor 
ªª Types of UI Components	 ª	 Blocks Editor and Its Interface 

Creating Apps with MIT App Inventor9
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ªª Creating an App	 ª	 Testing Your App 

Teaching Plan�

Number of Periods
Theory Practical

2 2

Before starting the chapter, ask the students to solve the question in BRIDGE BACK given on page 
125 of the main course book.

Start by introducing the concept of mobile applications (apps). Explain that apps are software 
programs designed to perform tasks such as learning, gaming, chatting, watching videos or managing 
activities on smartphones and tablets. 

Discuss how mobile apps are widely used in everyday life and how they can be downloaded from 
app stores such as Google Play Store or Apple App Store.

Explain the features of mobile apps, such as user-friendly design, touch-friendly controls, notifications 
and security settings that help protect user data. 

Introduce the types of mobile apps and explain the differences between them:

•	 �Native Apps: Designed for a specific operating system such as Android or iOS and downloaded 
from app stores.

•	 Web Apps: Accessed through web browsers and do not need installation.

•	 Hybrid Apps: Combine features of both native and web apps. 

Explain the categories of mobile apps, such as educational apps, lifestyle apps, social media apps 
and gaming apps. Provide examples and discuss how each category serves different purposes. 

Introduce MIT App Inventor, explaining that it is a free, cloud-based tool that allows users to create 
mobile applications using a visual block-based programming system similar to Scratch. 

Demonstrate how to start MIT App Inventor by opening the website, signing in with a Gmail account 
and creating a new project. 

Explain the Project Designer window, which is used to design the app interface. Discuss its main 
sections:

•	 Palette Pane – contains components such as buttons and images.

•	 Viewer Pane – shows how the app screen looks.

•	 Components Pane – lists all added components.

•	 Properties Pane – allows users to modify the properties of components. 

Introduce UI components and explain that they are visual elements that users interact with in an app. 
Discuss common components such as Button, Label, TextBox, Image, ListView and Switch. 

Explain the Blocks Editor, where the app’s behaviour is programmed using blocks that connect like 
puzzle pieces. Discuss important parts such as built-in blocks, component-specific drawers and the 
viewer area. 
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Discuss different types of blocks used in MIT App Inventor, including:

•	 Control blocks for program flow

•	 Logic blocks for decision making

•	 Math blocks for calculations

•	 Text blocks for working with text

•	 List and dictionary blocks for storing data

•	 Variable blocks for storing changing values

•	 Colors Block for picking and using colours 

•	 Procedure blocks for reusable instructions 

Demonstrate how to create a simple multiplication table app using labels, text boxes, buttons 
and list views to display results. Explain how loops and variables are used to calculate and display 
multiplication values. 

Explain how to test the app using the MIT AI2 Companion mobile application by scanning a QR code 
or entering a connection code. This allows students to see their app running on a real mobile device. 

Encourage students to experiment with different UI components and blocks to design their own 
mobile applications.

Extension

Ask the students some oral questions based on this chapter.

Q.	 What are mobile apps and where are they used?

Q.	 What are the main features of mobile apps?

Q.	 What are the three types of mobile apps?

Q.	 What are some common categories of mobile apps?

Q.	 What is MIT App Inventor?

Q.	 What are the main sections of the Project Designer window?

Q.	 What are UI components in an app?

Q.	 What is the Blocks Editor used for?

Q.	 What are variables and loops in app development?

Q.	 How can you test an app created using MIT App Inventor?

Evaluation

Ask the students to complete the elements like ASK AI AGENT given on page 139.

Ask the students to complete the elements like RAPID RECALL given on page 126.

Encourage the students to complete tasks like EART INTEGRATION activity given on page 127.
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After explaining the chapter, let the students do the LEARNING LOGS on pages 140 to 142 in the 
main course book. Tell the students to try sections such as CODE CHECK given on page 142 in the 
main course book.

Take the students to the computer lab and let them practice the activity given in the LAB LEARNING 
section on page 142 in the main course book. This will enhance the ability of the students and serve 
as a technology literacy activity.

Suggested Activity

Ask students to design a simple mobile app concept. They should think of a useful app idea such as a 
quiz or reminder app sketch the layout showing buttons labels and text boxes use MIT App Inventor 
to create the interface add blocks for actions and test the app using the MIT AI2 Companion app. 
Have students present their app ideas and explain how it could solve everyday problems.

Teaching Objectives

Students will learn about
ªª Introduction to AI Industry 5.0 
ªª Need for AI Industry 5.0 
ªª Basic Components of Robots 
ªª Future Possibilities 

Teaching Plan�

Number of Periods
Theory Practical

3 1

Before starting the chapter, ask the students to solve the question in BRIDGE BACK given on page 
145 of the main course book.

Start by introducing the concept of AI Industry 5.0 and explain that it focuses on collaboration between 
humans and robots. Unlike earlier industrial stages that focused mainly on automation, Industry 
5.0 combines human creativity and artificial intelligence to improve productivity, sustainability and 
innovation. 

Discuss how robots are used in different fields, such as healthcare, farming, space exploration, defence 
and home environments. Explain that robots can automate tasks, analyse data and assist humans in 
performing complex work more efficiently. 

Introduce the concept of robots in AI Industry 5.0 and explain that robots can work alongside humans 
to perform repetitive or dangerous tasks while humans focus on creative and decision-making roles.

AI Industry 5.0: Smart Rotbots10
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Explain the different application areas of robots, including:

•	 Factory robots that perform tasks such as welding, assembly and packing.

•	 Home robots that assist with household tasks and daily activities.

•	 Military robots used for surveillance, combat and rescue operations.

•	 Medical robots used for surgery, rehabilitation and prosthetic support.

•	 Farming robots that help with harvesting, weed control and crop monitoring.

•	 Delivery robots that deliver food, medicines and parcels using sensors and GPS.

•	 Space robots used for exploration, spacecraft repair and collecting scientific data. 

•	 Travel Robots used to assist with luggage, navigation and support at airports, hotels.

•	 Fun and Entertainment Robots to manage cameras, create effects and perform stunts

Explain the need for AI Industry 5.0, highlighting its benefits:

•	 Increasing efficiency and productivity by performing tasks quickly and accurately.

•	 Reducing human effort in repetitive or dangerous tasks.

•	 Improving workplace safety by working in hazardous environments.

•	 Supporting healthcare through advanced robotic surgeries and rehabilitation systems.

•	 Helping in education by supporting STEM learning and innovation.

•	 Improving everyday life by assisting with daily activities and personal tasks. 

Introduce the basic components of robots and explain that several parts work together to make a 
robot function properly. These include:

•	 Sensors that detect motion, light, temperature or distance.

•	 Actuators that convert electrical signals into movement.

•	 Motors that help the robot move its joints, wheels or limbs.

•	 Controllers that act as the brain of the robot by processing sensor data and controlling actions. 

Discuss the future possibilities of AI Industry 5.0, explaining that future robots will help create 
personalised products, use eco-friendly processes and improve safety while working closely with 
humans. 

Encourage students to think about how robots might help solve real-world problems such as climate 
monitoring, disaster management and healthcare support.

Extension

Ask the students some oral questions based on this chapter.

Q.	 What is AI Industry 5.0?

Q.	 How is Industry 5.0 different from Industry 4.0?

Q.	 In which fields are robots commonly used today?
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Q.	 How do robots improve efficiency in industries?

Q.	 What are some examples of robots used in healthcare?

Q.	 What are the basic components of a robot?

Q.	  What role do sensors play in robots?

Q.	 How do motors help robots perform tasks?

Q.	 How can robots improve safety in dangerous environments?

Q.	  What future possibilities do robots offer for society?

Evaluation

Ask the students to complete the elements like ASK AI AGENT given on page 149.

Ask the students to complete the elements like RAPID RECALL given on page 147.

Encourage the students to complete tasks like INTERDISCIPLINARY LEARNING activity given on 
page 148.

After explaining the chapter, let the students do the LEARNING LOGS on pages 150 to 152 in the 
main course book. Tell the students to try sections such as CODE CHECK given on page 154 in the 
main course book.

Take the students to the computer lab and let them practice the activity given in the LAB LEARNING 
section on page 153 in the main course book. This will enhance the ability of the students and serve 
as a technology literacy activity.

Suggested Activity

Ask the students to make a powerpoint presentation on “Humanoid robots around the globe” and 
present it in the class.


